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Chapter 1: Overview of Integration with Scoring Machines 

 
Fencing Time can interface with scoring machines to enhance the tournament experience.  When using 
capable scoring machines, Fencing Time offers the following features: 
 

• Bouts can be called to the machine from Fencing Time and results of the bouts can be 
automatically recorded in Fencing Time.  This feature is available for pools, elimination bouts, 
and team matches.  This drastically cuts down on the amount of data entry the computer 
operator must do manually. 

• When publishing an event on Fencing Time Live, nearly real-time scoring machine data (lamps, 
scores, time, etc.) can be displayed on a page on the Fencing Time Live website 
(www.fencingtimelive.com.) 

• The scoring machine state can be displayed on large screens at the strip using the Fencing Time 
StripView application. 

 
This guide will outline what hardware and software is needed, how to set up your network, and how to 
configure the Fencing Time system to enable these features.   
 

Supported Scoring Machines 

Fencing Time communicates with the scoring machines over the local computer (ethernet) network 
using the FIE Cyrano (v1.0 or v1.1) protocol.  As of this writing, the only scoring machines that support 
network communication are: 
 

• Allstar FMA21 

• Favero FA-07 

• Escrime Technologies / St. George WSG-31 
• Absolute Fencing World Series Scoring Machine  

• Virtual Scoring Machine Tournament Version 

Any newly developed scoring machines with an ethernet network port that supports Cyrano should also 
work with Fencing Time. 
 

Software Requirements 

The following software is needed to run Fencing Time with scoring machine integration: 
 

• The main Fencing Time (client) application.  Fencing Time can be run either as a stand-alone app 
or connected to a Fencing Time server. 

• The Fencing Time Scoring Device Manager application 

• (optional) The Fencing Time StripView application 

All of the above software can be downloaded from the Fencing Time website at www.fencingtime.com. 

https://www.fencingtimelive.com/
https://www.fencingtime.com/
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Hardware Requirements 

At least one Windows PC is required to run Fencing Time and Fencing Time Scoring Device Manager.   
 
To run StripView, you will need a Windows PC with a large display screen at each location that you want 
to display the scoring machine state.  The most common configuration is one screen at each strip, but 
there is no limit to how many PCs with screens that you can use. 
 
All of the PCs and scoring machines need to be on the same computer network.  Depending on your 
situation, this will require a router, network cables, and possibly one or more network switches to 
connect all of the components.  Use of wireless networks is NOT recommended. 
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Network Architecture 

The diagram below shows a typical network architecture.  As the diagram shows, you can use either a 
single Fencing Time PC or multiple PCs when running the Fencing Time server.  The StripView PCs and 
large screens are optional. 

 
Each device on the network must have a unique IP address.  PCs will usually acquire an IP address from 
the router automatically.   
 
Depending on which model of scoring machine you are using, the method for assigning IP addresses 
varies.  For example, the WSG-31 and Absolute World Series machines assign a fixed address in the 
192.168.1.xxx address space based on what strip number the machine is assigned to.  The Allstar FMA-
21 uses addresses in 172.20.0.xxx address space.  The Favero FA-07 is the most flexible and lets you set 
the IP address to whatever you want. 
 
Refer to the instruction manual for your scoring machine to determine how to set the IP address.  You 
may also need to change the configuration of your network router to match the address space used by 
the scoring machine.  It is important to confirm that the router’s range of IP addresses used for DHCP 
does not overlap with any of the static IP addresses that you are using.  
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Chapter 2: Fencing Time Scoring Device Manager 

 
Fencing Time Scoring Device Manager (“FTSDM”) is the app used to interface the scoring machines with 
Fencing Time.  It can be downloaded from www.fencingtime.com and is free to use; no license is 
necessary. 
 
If you are using the single-user version of Fencing Time, FTSDM should be installed on the same PC as 
the main Fencing Time app.  If you are using the Fencing Time server, you can install FTSDM on any PC 
on the network.   
 

Starting Scoring Device Manager 

When you start FTSDM, you will be presented with two options: 
 

 
 
If you are running the single-user (standard) version of Fencing Time, you must first launch the main 
Fencing Time app, then select “Get data from the Fencing Time program running on this computer”.  
Fencing Time must always remain running while running FTSDM. 
 
If you are using the Fencing Time server, select the second option and enter the name or IP address of 
the server computer.  If you are running FTSDM on the server computer, you can use the name 
“localhost” which basically means “this computer”. 
 
If you are using VSM scoring machines with the latest VSM Tournament Version (release G5 or later) or 
are going to use the StripView bout selection scanning feature, select the option for the “enhanced 
integration mode” to fully take advantage of these features. 
 
After making your selection and choosing the language to use, click OK to launch the app. 
 

  

https://www.fencingtime.com/
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Scoring Device Manager Overview 

The main window of FTSDM has three general areas: the main menu bar (File, View, and Options), the 
tournament selection options, and the scoring device list. 
 

 
 
Initially, no tournament will be selected in the section at the top.  When you are ready to start using 
FTSDM at a tournament, you will select which tournament to use.  This is necessary so that FTSDM 
knows which events are available to be assigned to your scoring machines. 
 
The list of scoring devices will initially be empty since you have not yet added any devices.  Once added, 
the list will show the strip number of each device, its IP address, what it is currently being used for, the 
status of the device, any warnings or errors that have been encountered, and if the device is set to 
appear on Fencing Time Live. 
 

Registering Scoring Devices 

Fencing Time Scoring Device Manager acts as the “bridge” between Fencing Time and the scoring 
machines.  In order to do this, it needs to know where it can find each scoring machine on the network, 
and how each machine will be used. 
 
The first step in setting up FTSDM is to register your scoring devices.  To do this, click “New Device” at 
the bottom of the window.  This will bring up the Edit Scoring Device window: 
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Right now, all we need to do is tell FTSDM which strip the device is on, what model of device it is, and 
what its IP address is.  Enter the strip number (or name) in the box at the top and enter the model and IP 
address of the scoring machine in the Cyrano section.  Leave the port set to 50100 (or 50101 for the 
Absolute WS/SG31 machines) and the Cyrano version set to 1.0 (unless you know your device supports 
Cyrano 1.1.)   
 

 
 
When you are finished entering the information, click OK.  Repeat the device creation process for all 
scoring machines present on your network. 
 
 

Important Note About Strip Numbers 
FTSDM uses strip numbers to determine which bout should be sent to the scoring 
machines.  The strip numbers that you assign in FTSDM need to match the strip 
numbers that you use when assigning strips to pools or bouts in the main Fencing 
Time app.  For example, if you assign strips in Fencing Time using French colors (bleue, 
rouge, verte, and jaune), you must use the identical names in FTSDM when creating 
the devices (i.e. you can’t use the English names blue, red, green and yellow.)  If the 
strip numbers/names do not match identically, things will not work. 
 
If you are using the WSG-31 or Absolute World Series machines, the strip 
number/name that the machine is set to using the machine’s configuration menu is 
irrelevant.  That strip number/name is only used to select the IP address the machine 
will use.  The strip number/name set in FTSDM is the one that matters since that is the 
one used to match against the pools and bouts in Fencing Time. 
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Verifying Scoring Machine Connectivity 

Once all scoring devices have been created, you will see them listed on the FTSDM main screen.  The 
next step is to verify that FTSDM can communicate with the scoring machine.   
 
First, make sure that all scoring machines are turned on and connected to the network.  Some machines 
such as the Allstar FMA-21 and VSM must be set into the mode where they enable Cyrano 
communication – be sure this has been done if necessary. 
 
After a few seconds, the Status column for each machine should change from “Offline” to “Waiting for 
bout”.  If this does not happen after 10 to 15 seconds, that means FTSDM is not able to communicate 
with the machine.  If the status does change and is no longer “offline”, that means FTSDM has 
successfully established a connection with the scoring machine.  (Some scoring machines have a visual 
indicator like a lit LED to indicate they are connected to the tournament software.) 
 

Selecting the Tournament to Use 

Once you have verified that FTSDM can communicate with a scoring machine, the next step is to decide 
what fencing will take place on the strip that machine is on.  You can assign a pool, DE bout, or team 
match to the machine. 

 

 
 

Before you start assigning pools or bouts to the scoring machines, you must select which tournament 
you are operating on.  On the main Scoring Device Manager screen, click “Select Tournament” and then 
choose the tournament you wish to use when the list appears. 
 
If the tournament list does not appear, this usually indicates a problem communicating with Fencing 
Time.  If you selected “Get data from the Fencing Time program running on this computer” when you 
started FTSDM, make sure that the main Fencing Time app is still running.  If you chose the option to 
connect to a Fencing Time server, make sure the server PC is accessible from the PC running FTSDM.  
You can verify this by going to http://servername/FTWeb in a web browser running on the FTSDM PC 
(replace “servername” with your server PC’s name.) 
 
If you are able to see the tournament list but the tournament you wish to use is not listed, this could 
mean that there are either no events in the tournament that are in-progress 
 
Once you have selected the tournament to use in FTSDM, the tournament will be shown on the main 
FTSDM screen as the current tournament. 
 

Assigning Pools or Elimination Bouts to the Scoring Machines 

The final step that must be done before you start fencing a bout on the scoring machine is to tell FTSDM 
which event is using the strip and how the machine will be used.  The current event and use will be 
displayed in the scoring device list in the “Event / Use” column.  If a machine is not assigned, it will be 
listed as “Unassigned.” 

Currently, only team matches in elimination rounds can be assigned to a machine.  
Team matches in pools are not currently supported but may be in the future. 
 

http://servername/FTWeb
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To assign the event and use, click the edit button  on the device’s row to bring up the Edit Scoring 
Device window.  In the “Event” dropdown list at the bottom of the window, select the event with the 
pool or elimination bout that you wish to assign to the strip.  After selecting the event, the “Use” 
dropdown list will populate with several options.  The options that may be offered are as follows: 
 

• A specific pool in the event’s current round in progress 

• A specific elimination bout in the current round in progress 

• “All bouts assigned to this strip” 
 
The first two options are straightforward – you simply select the pool or specific bout to be fenced on 
the strip.  However, the “All bouts assigned to this strip” option needs explanation. 
 
The “All bouts assigned to this strip” option will only appear during elimination rounds.  Since it would 
be extremely burdensome to assign every elimination bout to their assigned strip as the tournament 
progresses, this option makes the process automatic. 
 
When the referee requests the next bout to be fenced on the strip, FTSDM asks Fencing Time to figure 
out which bout should be fencing on the strip.  This is done by looking at all of the bouts that have been 
assigned to the strip and at what time.  The unfenced bout with the earliest scheduled time will be 
selected and assigned to the strip. 
 
For this to work properly, you must follow these guidelines: 
 

• Elimination bouts must have the strip and time set in the main Fencing Time app 

• The strip numbers/names used in the main Fencing Time app must exactly match the strip 
numbers/names used in FTSDM 

• When an elimination bout has completed, the score must be entered into Fencing Time, either 
automatically by the scoring machine or manually by the computer operator. 

 
If the referee requests the next bout and no bout appears, it means that one of the above conditions 
has not been met, which prevents Fencing Time from determining which bout to send to the machine. 

 

 
 

Understanding the Bout Request and Results Submission Process 

It is important to understand how the process of requesting bouts and submitting results works.  With 
this knowledge, you should be able to troubleshoot problems that arise. 
 
The process is dictated by how the Cyrano protocol works.  In some ways it may seem inefficient, but 
unfortunately it is beyond our power to change it – we must follow the process that the protocol uses. 

When moving between a pool round and the elimination round, you will need to 
update all of the scoring machines and change them from being assigned to a pool to 
being assigned to “All bouts assigned to this strip” or a specific elimination bout.  The 
“Bulk Operations” button on the main FTSDM window will allow you to do this for 
multiple scoring machines at a time. 
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The most important thing to understand is that requests for bouts are made by the scoring machine 
when the referee wants the next bout.  FTSDM does not “send” the bout to machine until it is asked for 
a bout.  When you select the event and use for a scoring device in FTSDM, it does not have any effect on 
the scoring machine.  It just tells FTSDM where to look for the next bout when scoring machine requests 
it. 
 
All scoring machines that use the Cyrano protocol will offer four options on their remote control for 
managing the current bout: 
 

• NEXT – Requests the next bout.  In a pool, it is the next bout in the order of bouts to be fenced.  
In a team match, it is the next encounter between the team relay.  In an elimination round, it is 
the next bout assigned to the strip based on the time. 

• PREV – Requests the previous bout.  This function is only available in pools and lets the referee 
return to bouts already fenced. 

• BEGIN – Switches the scoring machine into “fencing” mode.  This must be done before starting 
the bout.  Some machines do not allow you to start the clock until BEGIN has been pressed. 

• END – Ends the bout and sends the results to Fencing Time.  Most scoring machines will have 
some kind indication that the results were accepted or rejected.  A rejection could occur if the 
score is tied and neither fencer has priority indicated.  Some scoring machines label this as 
VALIDATE instead of END. 

 
The standard procedure that the referee will follow is NEXT – BEGIN – (fence the bout) – END.  After 
ending the bout to submit the score, the process starts over by requesting the next bout with NEXT. 
 
A common mistake referees make is to forget to BEGIN or END the bout.  When this happens, the scores 
can be submitted for the wrong bout (or not submitted at all if they never press END.)  This is most 
common in pools.  If the scoring machine is connected to a display that shows the names of the on-strip 
fencers, it is less likely to be a problem, but it is important that the fencers hook up on the side of the 
strip indicated by the display (otherwise the results will be entered reversed.) 
 
When using the scoring machines to submit results, it is important to instruct the referees to record all 
scores on the paper score sheet just like they would if the scores were not being handled by the scoring 
machine.  The scores on the paper score sheet are the official scores – these are the ones the fencers 
should verify.  When the computer operator receives the score sheet, he/she should check to see if the 
scores submitted by the scoring machine match the scores on the paper score sheet and make any 
corrections if the data was submitted incorrectly. 
 

Monitoring Scoring Machine Activity 

Fencing Time Scoring Device Manager allows you to monitor the activity on the strips in two ways – 
either by observing the activity in the “Status” column on the list of scoring devices, or by showing a 
miniature view of the scoring machine that shows its status in real-time. 
 
To show the mini view of the strip, click the “eye” button on scoring device’s row in the device list.  This 
will show a small window with the scoring machine state (it may take a few seconds for it to update.)   
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To show the mini views for all of the strips, use the View > Live Scores > Show All menu option.  You can 
also use the Tile All option to arrange all of the mini views into a nice grid pattern. 
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Real-Time Scores on Fencing Time Live 

If you are publishing live results for your tournament on Fencing Time Live (www.fencingtimelive.com), 
you can supplement them with live, nearly real-time scoring machine data on your tournament’s page.  
 
Before you can publish live scores on Fencing Time Live, 
you must first publish your tournament from the main 
Fencing Time app.  Once the tournament has been 
published, you can enable live score publication. 
 
To enable live score publication, select the Options > Live 
Scores menu item in Scoring Device Manager.  This will 
show a window where you can enable or disable 
publication.  You also need to enter your Fencing Time 
Live access key on this page.  You must use the same 
access key that you are using to publish your tournament 
from the main Fencing Time app. 
 
After the publication is enabled, the “Scores” tab will 
appear on your tournament’s page on Fencing Time Live.  
However, it will initially be blank.  This is because you 
have not yet selected which scoring machines should 
publish their data. 
 
To enable a scoring machine to publish its data, open the 
Edit Scoring Device window for that scoring device.  
Check the box marked “Live scores on Fencing Time Live” 
to enable publication.   
 
By default, the strip number shown on Fencing Time Live will match the strip number assigned to the 
scoring device.  If you want the strip number on Fencing Time Live to be different, you can change it in 
the “as strip #” box. 
 

Other Scoring Device Manager Options 

The Options menu in FTSDM offers some other useful functions: 
 
Data Forwarding 
The data forwarding feature is used to forward the scoring machine data to other computers that need 
access to the data.  The most common uses are for sending data to the StripView app and/or live 
streaming systems.  Forwarding is discussed in detail in the StripView chapter. 
 
Send FIE IDs to Scoring Devices 
Choose this option to have FTSDM use the fencer FIE ID numbers rather than Fencing Time’s ID 
numbers.  This option is only needed when working with the Swiss Timing system. 
 
  

http://www.fencingtimelive.com/
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Only Send HELLO When an Event is Assigned 
FTSDM sends a “HELLO” message to each scoring machine every 5 to 10 seconds to maintain its data 
connection.  When an event isn’t assigned to a scoring device, this just creates unnecessary network 
traffic.  Selecting this option disables the sending of HELLO messages to machines that don’t have an 
event assigned to it.  When using this option, the machine will appear offline in the device list when 
unassigned. 
 
Enable Logging 
When logging is enabled, FTSDM records all of the data sent and received to/from each scoring 
machine.  This can be useful for troubleshooting problems, but it can also generate a lot of data stored 
on your PC.  By default, this option is disabled, but you can enable it if necessary.  To view the logged 
data, use the View > Log File menu option. 
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Chapter 3: Fencing Time StripView 

 
Fencing Time StripView is an app used to display the state of a scoring machine on a large screen.  It will 
show the fencer names and their nation’s flag, the score, clock, penalty cards, priority, and the scoring 
machine red, green, and white lamps.  All of these items will be updated in real-time using data coming 
from the scoring machine. 
 
StripView runs on a Windows PC that is connected to a large display screen.  Usually, StripView is used 
for large screens at the strip.  Each screen needs a PC to run StripView, although a PC with two video 
outputs could connect to two screens and run two copies of StripView, one for each screen. 
 
StripView can receive data from the scoring machine in two ways: via the network, or via a serial 
connection.  Both methods will be explained in subsequent sections. 
 
StripView also runs in two modes: full screen mode, or “watch” mode.   Full-screen mode is the standard 
way to use StripView as a display for one strip, while watch mode is useful for monitoring multiple strips 
at a time. 
 

Running StripView with a Network Data Source 

The most common way to run StripView is by using the computer network as a data source.  This 
method uses Cyrano data that is output by the scoring machines containing the real-time status of the 
machine displays. 
 
To use the network data source, the scoring machine and StripView PC must be connected to the same 
computer network as the PC running Fencing Time Scoring Device Manager.  It is highly recommended 
that all connections use ethernet cables and that you do not use a wireless network connection. 
 
When using the network data source, you must be running Fencing Time Scoring Device Manager 
(FTSDM.)  This is because FTSDM acts as “middleman” for scoring machine data.  As was described in the 
last chapter, all of the scoring devices communicate with FTSDM.  To provide StripView with the data to 
display, FTSDM needs to transmit the data that it receives from the scoring machines to the PC running 
StripView on each scoring machine’s strip. 
 
There are two ways FTSDM can send data to StripView.  You must select one of the two options found 
on the Forwarding & Broadcasting form found by using the Options → Data Forwarding menu. 
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The first data transmission option is to set up a forwarding rule.  A forwarding rule specifies the IP 
address and port of the receiving PC, as well as which strip’s data should be forwarded to that PC.  When 
forwarding data to a PC, it is important to configure the PC to have a static IP address so that it does not 
change.  (By default, PCs get their IP address via DHCP which assigns them a random IP address.  This IP 
address can change, which would cause the forwarding rule to fail.  Static IP addresses do not change, 
which avoids this problem.) 
 
You will need to set up forwarding rules for each PC running StripView.  Unless you have a specific 
reason not to, it is recommended to use port 50103.  If you have one PC running two instances of 
StripView (usually when you have the PC connected to two screens), you will need to set up two rules 
with the same IP address but different strip numbers.  You will also want to use a different port number 
in this case – 50104 is recommended. 
 
The second transmission option is to use the data broadcast.  This method broadcasts the scoring 
machine data received from every machine to every PC on the network.  It requires less configuration, 
but unfortunately it can be unreliable.  Therefore, it is recommended that you not use the broadcast 
option except in very limited situations. 
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To select the network data source in StripView, click the “Change” button next to the data source 
indicator at the top of the StripView window.  This will bring up the input selection window: 
 

 
 
If you selected data forwarding in FTSDM, choose the forwarding option and enter the port number that 
you used in the forwarding rule for this strip in FTSDM.  If you enabled the network broadcast in FTSDM, 
enter the broadcast port that you used in FTSDM and the number (or name) of the strip that you wish to 
display the data for. 
 
After clicking “OK”, the StripView display should update with the scoring machine data for the selected 
strip after a few seconds.   
 

Running StripView with a Serial Data Source 

The other method to provide StripView with data is by using serial data.  Serial data is output by the 
scoring machines through the 9-pin DB9 ports that are normally used to attach “repeater” machines.  
Serial data can be used with every scoring machine, even ones that do not have network connections. 
 
To use serial data, you will need a PC with an RS422 serial port.   Serial ports are uncommon on PCs 
these days, so you will most likely need to buy an adapter which converts serial data to USB.  We 
recommend this one:  https://www.amazon.com/dp/B005CPLOVW 

https://www.amazon.com/dp/B005CPLOVW
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Connecting the serial adapter to the scoring machine may pose a problem.  Unfortunately, the pinouts 
of RS422 adapters are not standardized, so you may need to build a custom cable to connect the scoring 
machine and the serial adapter.  To make matters worse, each brand of scoring machine may require its 
own custom cable. 
 
Once you have the scoring machine connected to the StripView PC using the correct cable, open the 
data source selection window and choose “Direct connection (serial port)”.  Select which serial port to 
use from the dropdown list.  For the protocol, select the one your scoring machine uses (Swiss Timing 
2.0 usually works with all machines.) 
 
After you have made the data source selection, StripView should update with the scoring machine state.  
If it doesn’t after a few seconds, you may need to try a different protocol or check that your cable is 
working correctly. 
 

  

Do not confuse the RS422 serial format with the more common RS232 format.  They 
use the same cables and connectors, but they are NOT the same.  RS232-to-USB 
adapters will NOT work with scoring machines. 
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Other Full-Screen StripView Options 

The main StripView window offers many options that you can configure when running in full-screen 
mode: 
 

 
 
Screen Selection 
If your PC is connected to multiple screens, the screen selection dropdown lets you choose on which 
screen the StripView display should be shown. 
 
Display Options 
The display options allow you to customize the banner text at the top of the StripView display and add a 
logo image to the upper-right corner of the display. 
 
Mirror mode displays the fencers and lamps reversed from the normal orientation.  This can be useful if 
you have positioned the screen so that spectators are viewing it from behind the strip. 
 
The “Don’t show…” options allow you to hide the lamps, score, and/or clock from the display.  If you are 
experiencing a noticeable delay between when the lamps and clock change on the scoring machine and 
when the change happens in StripView, this option can “hide” this problem. 
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Competitors 
If the scoring machine does not provide the names of the fencers, you can manually enter their name 
and country.  If you have photos of the fencers, you can choose the photo to be displayed under their 
name on the screen. 
 
Advertisements 
When StripView has been idle for a period of time, it can go into a mode where it shows advertisements 
on the screen.  “Idle” means that no score, lamp, or clock changes have been detected for the specified 
amount of time.  When advertisements are enabled, StripView will cycle through the image files that 
you specify and display them in order.  The Fencing Time logo will also be displayed as part of the 
advertising cycle. 
 
Bout Selection 
When you are using the scoring machine to request bouts from Fencing Time, you normally need to set 
the pool or DE bout in Scoring Device Manager so that Fencing Time can provide the appropriate bout to 
the machine.  To simplify this process, if you have a barcode scanner attached to the PC running 
StripView, you can scan the barcode on the pool or DE scoresheet to select the pool or bout to be 
fenced on the machine.  After scanning the barcode, press NEXT on the machine remote control to load 
the bout on to the machine. 
 
To enable this feature, you must enter the PC name or IP address of the computer running Scoring 
Device Manager, as well as the strip number that StripView will be displaying. 
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Running StripView in Watch Mode 

Watch mode is an alternate mode for running StripView which allows 
you to monitor multiple strips at one time.  To select watch mode, 
choose “Multiple strip mini-displays” when StripView starts. 
 
After choosing watch mode, the main watch mode window will 
appear.  At the top is the usual data source selection.   Watch mode 
only makes sense when running in the networked mode, so it is 
unlikely that you will ever choose the direct (serial) connection when 
using watch mode.  
 
Watch mode lets you create multiple mini views, each one 
configured to watch a different strip.  To create a new watch mode 
view, click “New’.  This will open a window where you can select the 
strip number to watch, as well as a number of display options. 
 
Most of the options are self-explanatory – you can choose the screen 
position and size of the view, as well as whether you should hide or 
show some of the displayed elements.   
 
The Layout option offers two choices: Standard and Custom.  The 
standard layout displays the typical scoring machine layout of data.  
When custom mode is selected, the dropdown list is enabled.  This 
dropdown offers various custom views that you might use in special 
circumstances. 
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A Word About Display Lag 

StripView, like all similar apps, can suffer from “display lag”.  This is a short, but noticeable, delay 
between the when information appears on the scoring machine and then on the StripView display.  This 
is most noticeable with the clock and lamps. 
 
This delay is caused by several things.  When using the network as your data source, much of the delay 
comes from transmitting the machine data over the network to StripView.  When using a serial adapter 
as the data source, the delay is usually smaller, but it still can be present because of the conversion 
between serial and USB.  Since it is not possible to eliminate the display lag, you can take a few steps to 
make it less noticeable. 
 
The first way to mitigate the problem is to not position the StripView display near the scoring machine.  
When the display and scoring machine are near each other, both will be in the spectator’s field of vision, 
and they will notice the delay.  This is one reason why the displays are positioned above the strip at 
some competitions. 
 
If it is not possible to position the display away from the scoring machine, another good option is to 
choose the options that hide the lamps and clock.  When both are hidden, the scores are drawn larger, 
which makes the StripView display a nice supplement to the scoring machine. 
 


